
Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

 1. Inserted cells do not affect the position of existing cells.

 2. A column is hidden when it is frozen.

 3. Freezing rows and columns locks them in position on the screen.

 4. AutoComplete fills in formulas and cell addresses.

 5. Data bars are relative to the cell’s value.

 6. Fill creates a shadow effect around cell borders.

 7. The Merge and Center command works for multiple rows or columns.

 8. The Windows Clipboard and the Office Clipboard both store 12 items of 
cut or copied data.

Short Answer Questions
Write the correct answer in the space provided.

 1. What two commands help you enter labels in columns that already have 
many labels?

 2. If you want to repeat a lengthy label several times throughout a 
worksheet, would you cut it or copy it?

 3. What does the term “drag and drop” mean?

 4.  What is the default alignment for values and dates in a cell?

 5. What command will lock rows or columns in position on the screen?
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 6. What command combines several cells into one cell occupying the same 
screen space?

 7. How can you format a number to show leading zeros?

 8. What alignment option allows a label to split within a cell?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

 1. When you delete a row or a column, it is deleted across the entire 
worksheet. What problems could result from this?

 2. What are the advantages of AutoComplete and Pick From Drop-Down 
List? What are the disadvantages of each?

Skills Review

Exercise 4-29
Insert/delete sheets. Insert/delete cells. Use AutoComplete and Pick From 
Drop-Down List.

 1. Open Personnel. Save it as [your initials]4-29 in your Lesson 4 folder.

 2. Rename Sheet1 as Employees. Choose a tab color from the document 
theme colors.

 3. Insert and delete worksheets by following these steps:

  a. Right-click Sheet2 and choose Delete.

  b. Repeat these steps to delete Sheet3.

  c. Point at the Insert Worksheet tab and click.

  d.  Name the new sheet Interviews and choose a theme 
color.

NOTE

If you click an e-mail address, Excel 
launches your e-mail service and adds the 

address to the recipient list.
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 4. Insert and delete cells by following these steps:

 a. On the Employees sheet, right-click cell E13 and choose Insert.

 b. Choose Shift cells down and click OK.

 c. Key 5/29/78 in cell E13.

 d. Select cells F13:F14. Press � .

 e. Choose Shift cells up and click OK.

 5. Add data with AutoComplete by following these steps:

 a. Click cell A16 and key Biesterfield. Press .

 b. Key ka and press  or .

 6. Key kbiesterfield@kkic.net and press  or .

 7. Key today’s date in cell D16.

 8. Add data with Pick From Drop-Down List by following these steps:

 a. Right-click cell F16 and choose Pick From Drop-Down List.

 b. Choose Human Resources.

 c. Right-click cell G16 and choose Pick From Drop-Down List.

 d. Choose Klamath Falls.

 e. Insert Finance in cell F14 and Marketing in cell F15.

 9. AutoFit column C. Change columns A and B to 10.71 (80 pixels).

 10. Press � .

 11. Click the Insert tab. Click the Header & Footer button . Click the Go to 
Footer button . Key your first and last name in the left section. Insert 
the filename in the center and the current date at the right.

 12. Click the Page Layout tab. Drag the left margin marker to .50 inches or 
slightly less. Do the same for the right margin marker. Adjust column 
widths, if needed, to fit the worksheet on one page.

 13. Prepare and submit your worksheet. Save and close the workbook.

Exercise 4-30
Copy and paste cell contents. Insert and delete columns and rows.

 1. Open Personnel. Save the workbook as [your initials]4-30 in your 
Lesson 4 folder.

 2.  Click cell A16 and key McTavish. Ignore the 
AutoComplete suggestion. Press .

 3.  Key Diane and press . Key dmctavish@kkic.net and 
press .

REVIEW

You can press Tab  or  to enter data in 
a row.
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 4. Copy and paste cell contents by following these steps:

a. Press  and key h.

b. Click cell D8 and click the Copy button .

c. Click cell D16 and press .

d. Click cell E15 and display the drag-and-drop pointer.

e. Hold down  and drag a copy to cell E16.

   f. Click cell F7 and press � .

  g. Click cell F16 and press � . Press .

  h. Copy any city from a cell in column G to cell G16.

 5. Insert columns by following these steps:

  a. Right-click anywhere in column A. Choose Insert.

  b. Choose Entire column and click OK.

 6. Key Emp # in cell A2. Copy the format from cell B2 to cell A2.

 7. In cell A3, key 1 and press . In cell A4, key 2 and press . Select 
cells A3:A4 and use the Fill handle to fill in values down to cell A16.

 8. Drag the label in cell B1 and drop it in cell A1.

 9.  Delete columns and insert rows by following these 
steps:

  a.  Right-click the column D heading and choose Delete.

  b. Right-click the row 2 heading and choose Insert.

10.  In cell A2, key January 200X using the current year. 
Press � .

11.  From the Insert tab, create a header with your first 
and last name at the left, the filename in the center, 
and the date at the right.

12.  From the Page Layout tab, set the left and right 
margins to .50 inches.

13.  Prepare and submit your work. Save and close the 
workbook.

Exercise 4-31
Use cell alignment options. Use Merge and Center.

 1.  Open EmpNo. Save it as [your initials]4-31 in your folder.

 2. Use cell alignment options by following these steps:

  a. Click cell D2. Hold down  and click cell G2.

  b.  Click the Center button  in the Alignment group.

  c.  Click cell A2 and click the Wrap Text button .

  d. Click the Center button .

 3.  Change column A to 10.71 (80 pixels) wide. Change 
row 2 to 30.00 (40.00 pixels) high.

EX-4 UNIT 1 Introduction to Excel

NOTE

If you paste copied cells where there 
is existing data, the copy replaces the 

existing data.

REVIEW

Use the Format Painter to copy the font, 
size, and style.

NOTE

The date is formatted in a default style for 
your computer.

REVIEW

Use the Ctrl  key to select nonadjacent 
cells.
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 4. Rotate text by following these steps:

a. Edit the label in cell A2 to show # instead of Number.

b. Select the range A2:G2 and press � .

c. Click the Alignment tab.

d.  Drag the red diamond in the Orientation box to reach 30 degrees. 
Click OK.

 5. Change row 2 to 60.00 (80 pixels) high.

 6. Use Merge and Center by following these steps:

a. Select the range A1:G1.

b. Click the Merge and Center button .

 7. Delete Sheet2 and Sheet3. Rename Sheet1 as Personnel and choose a tab 
color.

 8. Create a footer with your first and last name in the left section, the 
sheet name in the center section, and the date in the right section.

 9. In Page Layout View, change the left and right margins to fit the 
worksheet on the page.

 10. Prepare and submit your work. Save and close the workbook.

Exercise 4-32
Use cell alignment. Apply borders. Use data bars.

 1.  Create a new workbook and save it as [your initials]4-32 
in your folder.

 2.  Key Klassy Kow Ice Cream, Inc. in cell A1 and make it 16-
point. Key Planned Interviews in cell A2 and format it as 
12-point bold. Change to the Solstice document theme.

 3.  Key the labels, dates, and times shown in Figure 4-23. Use default date 
and time formats for your computer.

REVIEW

Change the document theme on the Page 
Layout tab.

Figure 4-23   A B C D

 3 Name Date Time Experience

 4 Jonathan Aria May 24 9 am 2

 5 Christophe Kryztish June 5 11 am 5

 6 Melinda Dapoulas June 5 2 pm 3

 7 Pamela Dryzski June 8 10 am 5

 8 Yoshima Sato June 9 10 am 2

 4.  Make the labels in row 3 bold. Change column A to 
16.88 (140 pixels) wide. Change columns B:D to 10.00 
(85 pixels) wide.

NOTE

Character space and pixel measurements 
depend on the default font.
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 5. Use cell alignment by following these steps:

 a. Select the range A1:D2.

 b. In the Alignment group, click the Dialog Box Launcher.

 c.  Click the Horizontal arrow and choose Center Across Selection. 
Click OK.

 d.  Select the labels in row 3 and click the Center button .

 e.  Select cells D4:D8 and click the Dialog Box Launcher in the 
Alignment group.

 f.  Click the Horizontal arrow and choose Right (Indent). In the Indent 
box, choose or key 2. Click OK.

 6. Apply borders by following these steps:

 a.  Click the row 4 heading and drag to select row 5. Right-click and 
choose Insert.

 b. Select the range A3:D3.

 c.  In the Font group, click the arrow next to the Borders button . 
Choose Top and Bottom Border.

 d.  Select the range A4:D4. Click the Dialog Box Launcher in the Font 
group. Click the Border tab.

 e.  In the Style list, choose the dot-dot-dash line (first line, second 
column). Click the bottom border area in the preview box. Close the 
dialog box.

 f.  Set row 4 to a height of 4.50 (6 pixels). Set the height of row 5 to 
15.00 (20 pixels).

 g.  Select the range A12:D12. Click the down arrow next to the Borders 
button . Choose Bottom Border.

 h. Select the range A11:D11. Press � . Click the Border tab.

 i.  In the Style list, choose the dot-dot-dash line. Click the bottom 
border area in the preview box. Close the dialog box.

 j.  Set the height of row 11 to 15.00 (20 pixels)  and row 12 to 4.50 
(6 pixels). Make row 3 the same height as row 2.

 7. Use data bars by following these steps:

 a.  Select cells D6:D10. Click the Conditional Formatting button  in 
the Styles group.

 b. Choose Data Bars and then Green Data Bar.

 c.  Click the Conditional Formatting button . Choose Manage Rules.

 d.  Choose Edit Rule. Set the Bar Color to a shade of gray. Click OK to 
return to the worksheet.

 8.  Press � . Delete Sheet2 and Sheet3. Rename 
Sheet1 as Interviews and choose a tab color to 
coordinate with the data bar.

 9.  In Page Layout View, change the left and right margin 
to 2.25 inches.

10.  Create a header with your first and last name at the left, 
the sheet name in the center, and the date at the right.

 11. Prepare and submit your work. Save and close the workbook.

TIP

Use the view switcher buttons on the 
status bar to quickly change views while 

working.
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Lesson Applications

Exercise 4-33
Cut, copy, and paste data. Use borders and cell alignment. Add data bars.

 1. Open KowOwow and save it as [your initials]4-33 in your folder.

 2. On the Oregon sheet, cut the “Ashland” row and insert it before 
the “Eugene” row. Cut the “Medford” row and insert it before the 
“Roseburg” row.

 3. Copy the range A7:A11 to A15:A19.

 4. Key the following values for 2007:

Figure 4-24   Chocolate Vanilla

 2007

 Ashland 22000 21000

 Eugene 27000 28000

 Klamath Falls 20000 18000

 Medford 18000 16000

 Roseburg 17000 15000

   

 5. Shows sums in the range D7:D11 and in the range B12:D12. Apply the 
Comma style with no decimals to cells B7:D12.

 6. Center the labels in rows 1:2 over the data. Align the labels in row 3 to 
balance the data in each column.

 7. Set the row height for rows 14:19 to match the 2007 data. Create 
borders in rows 20:21 to mirror those in rows 4:5.

 8. Use orange data bars for cells D7:D11.

 9. Add a footer. Set the left margin so that the sheet appears centered on 
the page.

10.  On the California sheet, copy cells A5:A19 to cells 
A22:A36. Show totals for 2007.

11.  Format values to show commas and no decimals. 
Center the labels in rows 1:2 over the data. Adjust the 
alignment of the labels in row 3 for better balance.

12.  Select cells A5:D18. Apply dotted-line middle and bottom horizontal 
borders. Do the same for the lower half of the sheet.

NOTE

Use the Borders dialog box to design 
special borders.
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 13. Add a custom header to the sheet. Set the left margin so that the sheet 
appears centered.

 14. Prepare and submit your work. Save and close the workbook.

Exercise 4-34
Insert and move worksheets. Align labels; use borders and fill. Copy data 
and formats.

 1. Open EstKowO and save it as [your initials]4-34 in your folder.

 2. Insert two new worksheets and name them Nevada and Washington.

 3. Arrange the worksheets so that they are in alphabetical order, left to 
right. Use a different accent color for each tab.

 4. On the Oregon sheet, center the labels in rows 1:2 over the data and apply 
a lighter shade of the tab color as fill. Right-align the labels in row 3.

 5. Use the tab color for a double top border for row 1. Apply a double 
bottom border to row 2 using the same color. Make each of these rows 
slightly taller. Then set the vertical alignment of cell A2 to Center so that 
the amount of space above the labels appears to be equal to the space 
below.

 6.  Select cells A3:D18. Use the Border tab to apply single 
inside borders and single left, right, and bottom 
borders (same color as the tab). Apply single side 
borders to rows 1:2 to complete the design.

 7.  Copy and paste cells A1:D4 on the Oregon sheet to 
the same range on the Nevada sheet. Click the Paste 
Options button  and choose Keep Source Column 
Widths. Paste with the same options to the Washington 
sheet.

 8. Copy cells B5:D11 from the Oregon sheet to the Nevada sheet. From the 
Paste Options, choose Formatting Only. Paste with the same options to 
the Washington sheet.

 9. Change the fill and border colors on the Nevada sheet to match its tab 
color. Add a footer. Do the same for the Washington sheet.

 10. Add a header to the Oregon sheet. Prepare and submit your work.

 11. Save and close the workbook.

Exercise 4-35
Insert columns. Cut cells. Use cell alignment and borders. Add data bars.

 1. Open EstKowO and save it as [your initials]4-35 in your folder.

 2. On the California sheet, insert a column at column C. Move the label in 
cell A4 to cell B4. Move the label in cell A21 to cell C4.

NOTE

Do not press Enter  to complete a paste 
command if you want to use the Paste 

Options.

UNIT 1 Introduction to ExcelEX-8

hin1926X_EXL4_EX01-EX10.indd Page EX-8  9/29/08  8:00:26 PM s-080hin1926X_EXL4_EX01-EX10.indd Page EX-8  9/29/08  8:00:26 PM s-080 /Volumes/207/MHBR074/work%/indd%0/excel%0/media%0/Volumes/207/MHBR074/work%/indd%0/excel%0/media%0



 3. Move cells B22:B36 to cells C5:C19.

 4.  Insert a column at column E. Copy the labels in cells B4:
C4 to cells D4:E4. Move cells D22:D36 to cells E5:E19.

 5.  Fix the formula in cell F5 and copy it to the 
appropriate cells.

 6.  Center-align the labels in row 4 and cell F3. Merge and 
center cells B3:C3; do the same for Vanilla. Center the 
labels in rows 1:2 over the data. Delete all data below 
row 21.

 7.  Apply Accounting Number Format for rows 5 and 19 but 
remove the decimal places.

 8.  Insert a column at column D and make it 2.14 
(20 pixels) wide. Then set single left and right borders 
for cells D3:D19. Apply a single-line top border to cells 
A3:G3.

 9. Set gray data bars for cells G5:G18.

 10. Add a header and prepare and submit your work.

 11. Save and close the workbook.

Exercise 4-36  Challenge Yourself
Cut and paste rows. Change cell alignment and data bars.

 1. Open JulyCakes and save it as [your initials]4-36.

 2. Arrange the flavors in alphabetical order. Show quarterly sums.

 3. Change the labels in rows 1:3 to the headings font. Then choose a larger 
size for the labels in rows 1:2 and center them across the data.

 4. Format the values with Comma style but no decimals.

 5. Change to the Concourse document theme. Make other adjustments and/
or format enhancements that you think are necessary.

 6. Delete the data bars.

 7. Add a header. Turn off printing and viewing for gridlines and row and 
column headings.

 8. Prepare and submit your work. Save and close the workbook.

TIP

If you prefer to use drag and drop, 
reduce the Zoom size to see more on 

screen.

TIP

A column filled with # symbols means the 
column is not wide enough.
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On Your Own
In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and be 
creative.

Exercise 4-37
Create a new workbook and save it as [your initials]4-37 in your Lesson 4 
folder. Key the names of eight people in your class, relatives, or coworkers. 
List each person’s city, state, favorite color, and preferred season, using 
AutoComplete or Pick From Drop-Down List when possible. Include a main 
label and labels for the columns. Apply fill and borders to enhance the 
readability. Add a header and save the workbook. Prepare and submit your 
work.

Exercise 4-38
Create a new workbook and save it as [your initials]4-38 in your folder. In 
cell A1, key Restaurants and Fast Food Shops. Enter column labels for the 
names of restaurants, phone numbers, cuisine (“Italian,” “Seafood,”), and 
average price. Key data for 15 establishments. Set data bars for the price 
cells. Format your work attractively. Add a footer and save the workbook. 
Prepare and submit your work.

Exercise 4-39
Create a new workbook that lists the day of the week and the actual date for 
every day last month in two columns. In a third column, key the outdoor 
temperature. Experiment with alignment and borders. Add data bars to the 
temperature data. Add a header and save the workbook as [your initials]4-39. 
Prepare and submit your work.
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